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Working with Parameters 
 
Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II introductory 
tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this tutorial 
 
The purpose of this tutorial is to show you how to use the different options in SAAM II to 
define and use the most commonly used types of parameters. You will learn 
 

• How to use the Parameters dialog box (Part 1a) 
• How to hand-fit a model to data by individually adjusting parameters or by using the 

SAAM II slider bar (Part 1b) 
• How to use the Transfer and Loss Attributes dialog boxes (Part 2) 
• How to create nonlinear transfers (Part 3) 
 
 

This tutorial is divided into parts to which you can refer individually for specific information. 
Once you know how to enter parameters in the Parameters dialog box, you can proceed to any 
specific part of this tutorial without needing the information that preceded it. 
 
Files Required 
 

Study Files: The study files for this tutorial are 
 

study_0_Para.stu 
study_0.stu 

 
These files are included as part of this tutorial. The file study_0.stu is the same as 
study_0.stu that is installed in the SAAM II program folder and referred to in the 
SAAM II examples and tutorials. The file study_0_Para.stu is the same with the 
exception that the Parameters dialog box is empty.  
 
  



Introduction 
 
This tutorial is designed to show you have to use the different options available in SAAM II to 
work with the most commonly used types of parameters. 
 
The first two tutorials explain how to use the different features in the Parameters dialog box by 
hand-fitting a model to data. The second explains how to use the features in the Transfer and 
Loss Attributes dialog boxes. Taken together, this information will cover most of what users 
will need to know about working with parameters in SAAM II. 
 
The next tutorial explains how to create nonlinear parameters. The example used for the 
nonlinear parameters is Michaelis-Menten. SAAM II is not restricted only to this; any 
nonlinearity can be written using standard FORTRAN notation.  
 
“Working with Parameters, Advanced” shows how to how to use the different additional options 
in SAAM II to define and use refine parameters. This will cover the following:  
 

• There may be instances, when the loss is at a constant rate independent of the mass in 
the ith compartment.  In these cases, a zero-order loss is required. 

 
• A multicompartmental model in SAAM II is specified by the compartments, transfers 

and losses. The transfers k(i,j) and losses k(0,i) specify the terms in the different 
differential equations created internally by SAAM II. These are called the primary 
parameters. Often there are a number of parameters – volumes, clearances, absorptions – 
that are functions of these primary parameters. These parameters can be specified as 
variables in the Equations dialog box.  

 
• Some models such as the commonly used two-compartment model can be re-

parameterized based upon the desired secondary parameters. 
 

• All adjustable parameters must have initial values specified with high and low limits. 
For an adjustable parameter, if you simply enter a value and click Save, SAAM II will 
create default high and low limits that are 10 times and 0.1 times the initial value. 
SAAM II actually uses the information in the limits as part of fitting. The information is 
a measure of how well you think you know your limits. If your limits are widely 
divergent from the initial value, you may have trouble fitting. This is because SAAM II 
thinks you don’t know the parameter very well. On the other hand, if you know a 
parameter reasonably well, this information should be included when you set the limits. 

 
• SAAM II has implemented a partial Bayesian option. The Bayesian option provides a 

means by which a priori information about a specific parameter, or parameters, can be 
entered in the Parameters dialog box. 

 



Part 1. a. Work with the Parameters dialog box 
 
This part of the tutorial will illustrate the very basic operations of the Parameters dialog box. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file study_0_Para. 

 
a. The file study_0_Para.stu should appear in the file list; if it does not, find the folder 

where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 

 

 
 

3. View the model and the experiment on the model. 
 

a. In the SAAM II Toolbox, click Experiment. The model of the experiment will 
appear as follows: 

 



 
 

This is the experimental model developed and used in the Getting Started with 
Compartmental tutorial. The difference is that no parameter values have been specified. 
If you examine the Data window, or the specifications for ex1 or s1, you will find the 
study file is complete except for the parameter values. The sample equation is 
“s1=q1/vol” so vol is a parameter. 

 
4. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, click 

Parameters . The Parameters dialog box will open, as shown below: 
 

 
 

 Notice that k(0,1) is selected and that its type is Adjustable. 
 



a. Type “0.1” in the Value box, and click Save. SAAM II will automatically generate 
Low and High limits that are an order of magnitude smaller and larger than the 
initial value. The Parameters dialog box will appear as follows: 

 

 
 

b. Single-click k(1,2) to select it. Notice k(1,2) is highlighted, but the information in the 
pane beneath the Parameters window has not changed. The Parameters dialog box 
will appear as follows: 

 



 
 

c. Click Save. The values that you entered originally for k(0,1) now appears as the 
values for k(1,2). The Parameters dialog box will appear as follows: 

 



 
 

d. Double-click k(2,1) to select it. Notice the name changes from k(0,1) to k(2,1) 
beneath the Parameters window, and that the Value, Low Limit and High Limit 
boxes have been cleared. The Parameters dialog box will appear as follows: 

 



 
 

 

 Single-clicking versus double-clicking parameters. There are occasions when you 
will be entering the same Value, Low Limit and High Limit for a number of 
parameters. If this is the case, then once you have entered the values for one 
parameter, you can single-click on each of the parameters to select them, and click 
Save to associate the current Value, Low Limit and High Limit with that parameter. 
Double-clicking a parameter will make it active and clear the Value, Low Limit and 
High Limit boxes so you can enter entirely new values. 

 
 

e. For k(1,2), enter “0.1” in the Value box, “0.01” in the Low Limit box and “0.05” in 
the High Limit box. Click Save. The following warning message will appear shown 
below superimposed on the Parameters dialog box: 

 



 
 

  Default low and high parameter limits. If you enter Low Limit and High Limit 
values directly, SAAM II will check to be sure that the Value that you entered for 
the parameter is within these limits. 

 
 

f. To fix the problem, click “OK” in the warning message box. Then enter “1” in the 
High Limit box, and click Save. 

 
g. Double-click vol to select it. Type “2000” in the Value box, and click Save. The 

Parameters dialog box will appear as follows: 
 



 
 
h. Click Done. 

 
5. Solve the model and view the solution 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . 
 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 

. The Plot and Table Variables dialog box will open. Be sure the List All 
Variables check box is not selected. 

 
c. Click s1:plasma to move this to the Current Selection pane. 
 
d. Click Done. If the plot is not in semilog, in the View menu, click Semilog. The plot 

will appear as follows: 
 



 
 

 
e. Close the Plot window. 

 
You may continue to work with the Parameters dialog box in Part 1.b. of this tutorial. Here you 
will learn some of the steps involved in hand-fitting your model to the data. If you do not wish 
to continue working with the Parameters dialog box, you may Quit the SAAM II 
Compartmental application. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Part 1.b.1  Hand-fit the model to the data. 
 
It is always a good idea to hand-fit the model to the data. In this way, you will learn which of 
the model parameters affect the different parts of the model solution. When you hand-fit your 
model to your data, you will change the values of the parameters in the Parameters dialog box. 
 

1. In the View menu, click Model Labels, and then click Values. Your model will appear 
as follows: 

 

 
The names of the transfer k(i,j) have changed to their current numerical value. 

 

  Model labels. You have the option to have the current values for the parameters 
appear associated with your model. If the values, or name, do not appear, this is 
because your compartments are too close together. Move the compartments farther 
away from each other. 

 
 

2. From the initial solution, it would appear that k(0,1) needs to be increased. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 

click Parameters . The Parameters dialog box will open. 
 
b. Change the Value of k(0,1) from “0.1” to “0.2”. There is no need to change the Low 

or High Limits. Click Save. The Parameters dialog box will appear as follows: 
 



 
 

  Hand-fitting. When you are hand-fitting your model to your data, you are changing 
the numerical values of your model parameters. In general, during this process, it is 
not necessary to adjust the Low Limit and/or High Limit each time you change a 
value. An exception is when you set a value of a parameter below the Low Limit, or 
above the High Limit; then you will need to change the appropriate value. You 
should also change these values if, after you hand-fit your model, a particular 
parameter value is near a limit, and you are proceeding to Fit your model to your 
data. 

 
 

c. Click Done. 
 

3. Re-Solve the model and view the solution. The plot, in semilog mode, will appear as 
follows: 

 



 
 

4. The model predicted value is still not decaying fast enough. Leave the Plot window 
open. Set the Value of k(0,1) equal to “0.3”. When you close the Parameters dialog 
box, the previous solution will disappear because the parameter values have changed. 
Re-Solve the model. The plot will appear as follows: 

 

 
 

5. Leave the Plot window open. The initial decay is not fast enough. Yet if you increase 
k(0,1) again, the model predicted values will decay faster than the data. Hence try 



increasing k(2,1) from “0.1” to “0.2”. When you Re-Solve the model, your model and 
plot will appear as follows: 

 

 
 

6. You see that increasing k(2,1) has accentuated the break in the model predicted curve. 
You should try adjusting k(1,2) to see how this affects the model solution. Finally, you 
will note that the vol is a little off because the model predicted value at time zero is 
greater than the data. Thus vol needs to be increased a little, say to 2200 or 2300. 

 
7. When you have finished your hand-fitting exercise, you may proceed Quit the SAAM II 

Compartmental application, or you can proceed to the next section to learn how to use 
the SAAM II parameter slider bar. 

 
 
 
 
 
 
 
 
 
 



Part 1.b.2  Hand-fit the model to the data using the parameter slider bar 
 
The parameter slider bar is another convenient way to hand fit your model to your data. The 
slider bar is in the lower part of the Parameters dialog box: 
 

 
 
Moving the adjustment tool, you can change the value of the selected parameter between its 
Low Limit and High Limit. To solve with the new value, you can click SOLVE in the 
Compute menu.  Alternatively, there is an Auto solve click box. If this box is checked, after 
you move the adjustment tool to the desired value and release the mouse, your model will 
solve and your plot, if open, will be updated. 
 

1. Reset your parameter values to the original starting values. The Parameters dialog box 
will appear: 

 

 
 

2. With k(0,1) active, slide the adjustment tool to the right to increase the value. For 
example: 



 

 
 

Notice the mouse is still on the adjustment tool, so while the value may be 0.4258 it has 
not been updated as the Current value for k(0,1). Release the mouse, and click Save. 
The Parameters dialog box will appear: 
 



 
 

3. Click SOLVE. Plot you solution. Your Drawing Canvas will appear, in part, as 
follows: 

 

 



4. In the Parameters dialog box, click Auto solve. The Parameters dialog box will 
appear: 

 

 
 
If you wish to have SAAM II re-Solve your model when you release the mouse from the 
adjustment tool, you activate Auto solve. 
 

5. Move the adjustment tool left to a lower value for the parameter. For example: 
 

 
  
 Notice that the new value, as a result of Auto solve being checked, has been inserted as 

the Current value for k(0,1). 
 

6. Release the mouse. You model will automatically SOLVE, and your PLOT will be 
updated as follows: 

 



 
 
You can continue to explore the Adjust value slide bar. When you have finished, Quit the 
SAAM II Compartmental application. Do not save the changes to study_0_Para since, if you 
do, the Parameters dialog box will contain the last set of values you entered. 
 
 
 
 
 
Part 1.b.c  Hand-fit the model to the data using the parameter slider bar: comparing to 

a baseline solution 
 
When hand-fitting a model to data, one often wants to compare a solution to a baseline solution. 
In SAAM II, this involves using Solutions in the Compute menu. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file study, and click on Exper. The 

Experiment will open. 
 

3. Solve the model.  
 

4. Click on the Compute Menu, and select Solutions. The Solutions dialog box will open 
(for more information on saving solutions, see the Tutorial on Saving Solutions): 
 



 
 

Enter “Baseline” in the Name Prefix box. Click Add.  The Solutions Variables dialog 
box will open. 
 

 
 
The baseline solution in which you are interested is s1. Click s1, and click Done. The 
Solutions dialog box will appear as follows: 
 

 
 



 
 
Close the Solutions dialog box. 
 

5. Change the value of, say k(0,1) to 0.2, and SOLVE. Plot the solution; it will appear: 
 

 
 

6. Compare this solution with the baseline solution. 
 

a. Open the PLOT AND TABLE VARIABLES dialog box using either the SET 
menu or the Select variables tool in the SAAM II Toolbox. Check the List All 
Variables check box so all variables are listed: 



 

 
 

b. Notice s1 and plasma are in the Current Selection pane. Hold the CTRL key 
down, and click s1{Baseline1}; this will now appear in the Current Selection 
pane: 
 

 
 

c. Click Done. Your plot will appear: 
 



 
 
Be sure to leave this plot open on your Drawing Canvas. 
 

7. Using the parameter slider bar with Auto solve selected to compare solutions. 
 
a. Open the Parameters dialog box; the plot and dialog box will appear as shown 

below (be sure Auto solve is selected): 
 

 
 
Remember the plot compares the current solution with k(0,1) equal to 0.2 compared 
with the Baseline1 solution where k(0,1) equals 0.1. 
 



b. Move the slider bar to a value for k(0,1) higher than 0.2; see below for example: 
 

 
 

When you release the mouse, because Auto solve is selected, your model will solve 
with the new parameter value and your plot will be updated: 
 

 
 



You can now scroll among different parameter values for k(0,1), and compare the 
solution to the baseline solution. You can also change parameters to investigate, 
and, by using Save Solutions, create another “baseline” solution for comparison 
purposes. You may also fit your model and save the base solution; Use Adjust 
value and Auto solve to view the effect of changing parameters to the fitted 
solution. For more information about Save Solutions, see the Save Solutions 
tutorial. 
 
 
 

Quit the SAAM II Compartmental application. Do not save the changes to study_0_Para 
since, if you do, the Parameters dialog box will contain the last set of values you entered. 



Part 2. Using Transfer and Loss Attributes dialog boxes. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 
 

a. The file study_0.stu should appear in the file list; if it does not, find the folder where 
you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 

 

 
 

3. View the model and the experiment on the model, and change the model. 
 
a. In the SAAM II Toolbox, click Experiment. The model of the experiment will 

appear as follows: 
 



 
 

b. Modify the model by adding a loss from Compartment 2. Your model for the 
experiment should appear as follows: 

 

 
4. Enter the parameter values as shown in the following Parameters dialog box: 
 

 
 



5. Solve the model and view the solution.  
 

a. In the View menu, click Model Labels, and then click Values.  
 

  Model labels. You have the option to have the current values for the parameters 
appear associated with your model. If the values, or name, do not appear, this is 
because your compartments are too close together. Move the compartments farther 
away from each other. 

 
 

b. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . 
 
c. Plot the solution. The plot will appear as follows: 
 

 
 

 The model will appear as follows: 
 

 



 
You can see the current values for the k(i,j) appear associated with the transfer and loss 
arrows. Obviously the model solution is not very satisfactory, but the parameter 
estimates are still close enough to Fit the model to the data. 
 

6. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar, click Fit 

. The following warning message will appear together with the model and the plot: 
 

 
 

First you can see the numerical values of the parameters and the fact that a good fit of 
the model to the data has been obtained. However the warning message indicates that the 
covariance matrix is unreliable and may indicate multiple solutions. The covariance 
matrix unreliable message means that SAAM II is having problems fitting your model to 
your data. This, together with the warning there may be multiple solutions, usually 
means you have too many parameters in your model, i.e. there are more parameters in 
the model than can be estimated from the data. The last part of the warning message, 
consider using Bayesian estimation, will be considered in a later part of this tutorial. 
 
The problem is how to reduce the number of parameters. There are several options 
which will be discussed below. The first will be fixing a specific parameter. 
 
Close the Compute Log and Plot window. 

 
7. Fix k(0,2) to a specified value – method 1. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 

click Parameters . The Parameters dialog box will open. 
 
b. Double-click k(0,2) to select it. 
 



c. Select the Fixed option. 
 
d. Type “0.05” in the Value box. Click Save. The Parameters dialog box will appear 

as follows: 
 

 
 

e. Click Done. 
 
f. Re-Fit the model to the data. The results are summarized as follows: 
 



 
 

  Fixed parameters. When you fix a parameter in the Parameters dialog box, it will 
appear in the dialog box with a Value, but no Low Limit or High Limit. When you 
“Fit” your model to the data, this parameter will not adjust. The value for the 
parameter will be displayed in the Statistics window following a “Fit”, but it will 
clearly be delineated as a fixed parameter. 

 
 

g. Close the Statistics and Plot windows. 
 
8. Fix k(0,2) to a specified value – method 2. 
 

There is another method to fix k(0,2) to a specified value using the Loss Attributes 
dialog box. 
 



a. Double-click on the loss k(0,2) from Compartment q2 to open the Loss Attributes 
dialog box. 

 
b. In the Equations pane, type “k(0,2) = 0.05”. The Loss Attributes dialog box will 

appear as follows: 
 

 
 

c. Click Done. If you open the Parameters dialog box, it will appear as follows: 
 



 
 

Notice k(0,2) no longer appears as a parameter. The reason is that it has been defined 
as an equation in the Loss Attributes dialog box; SAAM II no longer recognizes it 
as a parameter to be listed in the Parameters dialog box. 

 
d. Re-Fit the model to the data. The results will be essentially identical to the above 

with the exception of the information in the Statistics window which, in this case, is 
shown as follows: 

 



 
 

Notice k(0,2) does not appear as a fixed parameter as it did previously. The reason is 
that it is now defined by an equation. 

 

  Parameters defined by an equation. What is the difference between this solution and 
the previous one? The difference is in the case above, k(0,2) does not appear in the 
statistics window. In the first case, k(0,2) is a parameter that appeared in the 
Parameters dialog box. It just happened to be a fixed parameter set to a specific 
value; this was reported in the Statistics window. In the case above, k(0,2) is defined 
as an equation. It thus is no longer considered a parameter by SAAM II in terms of 
optimization. 

 
 

e. Close the Statistics and Plots windows. 
 
f. Open the Loss Attributes dialog box associated with k(0,2), and delete the equation 

“k(0,2) = 0.05”. Close the dialog box. 
 
9. Write a constraint equation between k(0,1) and k(0,2). 

 
Suppose you know there is a relationship between k(0,1) and k(0,2). Suppose, for 
example, you knew that k(0,1) was twice k(0,2). How would you specify this in your 
model? This can be written “k(0,1) = 2*k(0,2)”, or “k(0,2) = 0.5*k(0,1)”. The former 
would be written in the Loss Attributes dialog box associated with k(0,1); the latter with 
the Loss Attributes dialog box associated with k(0,2). 
 
a. Double-click the loss k(0,1) from Compartment q1 to open the Loss Attributes 

dialog box. 



 
b. In the Equation pane, type “k(0,1) = 2*k(0,2)”. The Loss Attributes dialog box will 

appear as follows: 
 

 
 

c. Click Done. 
 
d. Solve the model. The following warning message will appear: 
 

 
 

The warning message appears because a value for k(0,2) has not been specified.  
 
Click “OK”. 
 

e. Open the Parameters dialog box. 
 

(1) Double-click k(0,2) to select it. 
 
(2) Be sure k(0,2) is set as an adjustable parameter. 



 
(3) Type “0.05” in the Value box. 
 
(4)  Click Save. The Parameters dialog box will appear as follows: 
 

 
 
(5) Click Done. 
 

f. Re-Solve the model. The model will now solve because all parameter values have 
been specified.  

 
h. Fit the model to the data. The results are summarized as follows: 
 



 
 

The “Fit” is essentially the same as the previous ones. Now, however, k(0,1) appears 
as a derived variable. It is a function of k(0,2) defined by the equation “k(0,1) = 
2*k(0,2)”. The statistical information on k(0,2) carries over to k(0,1). It is important 
to note the difference between defining a parameter as a function of another 
parameter versus as an equation with a specified value. That is, you should compare 
this situation with the situation where k(0,2) was defined by the equation “k(0,2) = 
0.05”. In this case, k(0,1) and k(0,2) adjust to accommodate the relationship “k(0,1) = 
2*k(0,2)”. In the former case, k(0,1) adjusts to accommodate k(0,2) being fixed equal 
to 0.05. 

 

  Constrained parameters. Constrained parameters are parameters that are functions of 
other parameters. Constraining parameters reduces the number of parameters to be 
estimated from the data, and hence can improve the statistical information. However, 
there must be a rationale for such constraints. Constrained parameters are still model 



parameters, but appear as Derived Variables in the Statistics window since they are 
functions of the model parameters. 

 
 

g. Close the Statistics and Plot windows. Open the Loss Attributes dialog box 
associated with k(0,1), and delete the equation “k(0,1) = 2*k(0,2)”. 

 
10. (Optional) Write a constraint between k(1,2) and k(2,1). 
 

Suppose it is known that k(2,1) and k(1,2) are equal. How can this be specified in the 
model? 
 
a. Double-click the transfer k(1,2) to open the Transfer Attributes dialog box. 
 
b. In the Equation pane, type “k(1,2) = k(2,1)”. The Transfer Attributes dialog box 

will appear as follows: 
 

 
 

c. Click Done. 
 
d. Open the Parameters dialog box, and enter the parameter values as shown below: 
 



 
 

Notice k(1,2) does not appear in the list of parameters. The reason is it is constrained 
to equal k(2,1). 

 
e. Solve the model and view the solution. The solution is reasonable, so you can 

proceed to Fit the model to the data. 
 
f. Fit the model to the data. The results are summarized as follows: 
 



 
 

Again the results are satisfactory and compare favorably with the other “Fits” in this 
part of the tutorial. 
 

  Transfer and Loss attributes. The attribute dialog boxes associated with transfers and 
losses in the model give you great flexibility in specifying relationships among 
parameters. In each of the cases above, an equation of constraint was specified which 
reduced the number of parameters to be estimated from 5 (the four k(i,j) and vol) to 
4. In the next part of the tutorial, you will learn how to use these dialog boxes to 
specify nonlinear parameters. 

 
g. Close the Plot and Statistics windows. 
 

Quit the SAAM II Compartmental application. Do not save the changes to study_0. 



Part 3. Creating a nonlinear parameter 
 
SAAM II can deal easily with nonlinear compartmental models. One simply needs to decide 
which of the model parameters is nonlinear, and then write an equation defining the 
nonlinearity. In this part of the tutorial, the loss k(0,1) will be defined to have Michaelis-Menten 
characteristics. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 
 

a. The file study_0.stu should appear in the file list; if it does not, find the folder where 
you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 

 

 
 

3. View the model and the experiment on the model, and the Parameters dialog box. 
 



a. In the SAAM II Toolbox, click Experiment. The model of the experiment will 
appear as follows: 

 
 
b. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 

click Parameters . The Parameters dialog box will open. The Parameters 
dialog box should appear as follows: 

 

 
 

These are the parameters for study_0.stu. 
 

4. Modify k(0,1) so that it is a nonlinear parameter with Michaelis-Menten saturation 
kinetics. 

 



Suppose you cannot fit your data to a model with constant k(i,j). This situation usually 
arises when no combination of parameter values, or adding components to the model, 
can account for the characteristics in the data. It is up to the modeler to decide which of 
the model parameters are nonlinear, and how to specify the nonlinearity. 
 
In what follows, k(0,1) will be changed to a nonlinear parameter with Michaelis-Menten 
saturation kinetics. 
 
a. Double-click k(0,1) to open the Loss Attributes dialog box. 
 
b. In the Equation pane, type “k(0,1)=Vm/(Kd+q1)”. The Loss Attributes dialog box 

will appear as follows: 
 

 
 

c. Click Done. 
 
The result is that k(0,1) is no longer a primary model parameter, but is a function of two 
new parameters, Vm and Kd. Thus k(0,1) will no longer appear in the Parameters dialog 
box; Vm and Kd will. 
 

5. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, click 

Parameters . The Parameters dialog box will open. 
 

a. Type “10” as the Value for Kd, and click Save. 
 
b. Type “1e+06” as the Value for Vm, and click Save. The Parameters dialog box will 

appear as follows: 



 

 
 

c. Click Done. 
 

6. Solve the model, and view the solution. The solution, of course, is not particularly good 
since the data do not display nonlinear features. A plot of the solution is shown as 
follows: 

 



 
 

It is of interest, however, to plot k(0,1) which is no longer a constant but a function of 
time since q1(t) appears in the equation defining it. More specifically, if you introduce a 
nonlinear parameter in your model, since it is no longer constant, you should plot the 
transfer to see how it changes over the course of the solution. 

 
a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 

, or alternatively click the Select variables tool in the SAAM II Toolbar: 
 

 
 
 The Plot and Table Variables dialog box will open. Be sure the List All Variables 
check box is selected. 

 
b. Click k(0,1) to move this to the Current Selection pane. The Plot and Table 

Variables box will appear as follows: 
 



 
 

c. Click Done. The plot of k(0,1) will appear as follows (in linear mode with the Y axis 
scale set from 0 to 0.02): 

 

 
 

d. Close the Plot window. 
 
If you plot any other of the model parameters, since they are constant, the plot will 
appear as a straight line parallel to the x-axis. In the example here, k(0,1) is slowly 
increasing during the solution. 



 
Thus it is very easy to create nonlinear models in SAAM II. It is also easy to see how a 
nonlinear parameter behaves; in this case, it is slowly rising. 
 

You can Fit the model to the data if you wish. However, despite the fit shown in the 
following plot, this is not a situation when nonlinearity is supported by the data.  
 

 
 
If you Fit the model to the data, a warning message as shown below will appear that 
indicates there are more parameters in the model than can be estimated from the data.  
 

 
 
Thus while there will appear to be a good “Fit”, the statistics will appear as shown below: 
 



 
 

Clearly the statistics are not satisfactory. If you were considering the possibility in this 
particular situation that the model might be nonlinear, you can safely conclude that, if it is 
nonlinear, k(0,1) cannot display Michaelis-Menten kinetics. 

 
 
Quit the SAAM II Compartmental application. Do not save the changes to study_0. 
 


